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LỜI NÓI ĐẦU 

Trong giai đoạn hiện nay, hàng loạt các phần mềm thiết kế ứng dụng 

trong lĩnh vực cơ khí đã xuất hiện và phát triển rộng rãi trong cả nước cũng như 

trên thế giới. Sự ra đời của chúng giúp cho khâu thiết kế các bản kỹ thuật như: 

Bản vẽ lắp, bản vẽ chế tạo…. trở nên dễ dàng, nhanh chóng và chính xác hơn. 

Ngoài ra, chúng còn giúp cho việc mô phỏng các mô hình thật của sản 

phẩm trở nên trực quan và sinh động,  góp phần nâng cao chất lượng cho quá 

trình dạy học ngành  cơ khí nói chung và các ngành kỹ thuật khác nói riêng. 

Giáo trình “NX Unigraphics” là một trong những tài liệu quan trọng có 

thể giúp sinh viên dễ dàng thiết lập một bản vẽ cơ khí, đồng thời còn là tài liệu 

quý giá giúp cho người học có thể ứng dụng để thiết kế nhanh và chính xác các 

sản phẩm cơ khí, phục vụ tốt cho quá trình sản xuất. 

Tài liệu được biên soạn trên tinh thần chọn lọc những nội dung cơ bản, 

thiết thực nhất phù hợp với sinh viên, nhằm giúp người học: 

Nắm vững các lệnh tạo mô hình 3D của chi  tiết. 

Lắp ráp các chi tiết thành sản phẩm hoàn  chỉnh. 

Mô phỏng trình tự lắp ráp của các chi tiết. 

Xây dựng bản vẽ kỹ thuật 2D chính xác từ mô hình 3D đã thiết kế. 

Tác giả xin chân thảnh cảm ơn các giảng viên trong khoa đã góp ý để giáo 

trình được hoàn thiện. Tuy được biên soạn cẩn thận nhưng chắc chắn vẫn còn 

những thiếu xót nhất định. Chúng tôi mong nhận được những đóng góp ý kiến 

chân thành nhất của người đọc để giáo trình ngày càng tốt hơn. 

Hà Nội, ngày      tháng     năm 2021 

Nhóm  biên soạn 
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CHƯƠNG TRÌNH MÔ ĐUN 

Tên mô đun 22: NX Unigraphics 

Mã mô đun: MĐ 22 

Thời gian thực hiện mô đun: 120 giờ; (Lý thuyết: 40 giờ; Thực hành, thí 

nghiệm, thảo luận, bài tập: 72 giờ; Thi kiểm tra: 8 giờ) 

I. Vị trí, tính chất của mô đun: 

- Vị trí của mô đun:Trước khi học mô đun này học sinh phải học xong: 

các môn học, modul chuyên môn bắt buộc từ MH14 đến MĐ25 

- Tính chất của mô đun:Là mô đun bắt buộc. 

II. Mục tiêu của mô đun: 

- Kiến thức: 

Trình bày môi trường làm việc, những chức năng, công cụ cần thiết của 

phần mềm NX để thực hiện các bản vẽ kỹ thuật; 

Trình bày môi trường làm việc, những chức năng, công cụ cần thiết của 

phần mềm NX để thực hiện thiết kế các cơ cấu máy; 

Quy trình để thiết kế, lắp ráp và mô phỏng cơ cấu máy. 

- Kỹ năng: 

Thao tác thành thạo máy tính, khai thác được phần mềm NX; 

Thiết lập được bản vẽ, vẽ và hiệu chỉnh các đối tượng trong bản vẽ; 

Quản lý được các đối tượng, nhóm đối tượng trong bản vẽ; 

Kết xuất được bản vẽ. 

- Năng lực tự chủ và trách nhiệm: 

+ Có ý thức tuân thủ tốt các nội quy; 

+ Yêu nghề, có ý thức giữ gìn và bảo vệ tài sản, thiết bị. 

III. Nội dung mô đun  

1. Nội dung tổng quát và phân bổ thời gian: 
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STT Tên chương, mục 

Thời gian (giờ) 

Tổng số 
Lý 

thuyết 

Thực 

hành, thí 

nghiệm, 

thảo luận, 

bài tập 

Thi kiểm 

tra 

1 Chương 1: Giao diện của 

phần mềm UNIGRAPHICS 

NX10 

5 2 3  

2 Chương 2: Phác thảo 

UNIGRAPHICS NX10 
15 5 9 1 

3 Chương 3: Các lệnh thiết kế 

2D 
15 3 11 1 

4 Chương 4: Ghi kích thước 10 4 5 1 

5 Chương 5: Ràng buộc và 

cách sử dụng 
10 2 7 1 

6 Chương 6: Công cụ mô hình 

3D Dạng khối (Solid) 
20 6 13 1 

7 Chương 7: Công cụ mô hình 

3D Dạng mặt (Surface) 
15 8 7  

8 Chương 8:Công cụ chỉnh 

sửa mô hình Synchronous 

Modeling 

10 3 6 1 

9 Chương 9: Phần lắp ráp và 

xuất bản vẽ 

Thi kết thúc 

20 7 11 

1 

 

1 

 Cộng 120 40 72 08 
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Chương 1 

Giao diện của phần mềm UNIGRAPHICS NX11 

Mục tiêu của bài: 

- Cài đặt được phần mềm thiết kế UNIGRAPHICS NX11 

- Thiết lập được môi trường làm việc trong UNIGRAPHICS NX11  

- Trình bày được cách lưu trữ và chuyển đổi dữ liệu. 

1.1. Khởi động 

Trong chương trình này, chúng ta sẽ được làm quen với giao diện phần 

mềm cũng như là các lệnh thường dùng nhất cho việc dựng hình 3D.  

Sau khi đã cài đặt NX và đưa NX ra màn hình Desktop với biểu tượng 

 Để bắt đầu vào giao diện phần mềm, chúng ta cần khởi động NX đã 

cài đặt.  

Click Double vào biểu tượng NX .  

 

Hình 1.1 
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Phần mềm hiện lên. 

 

Hình 1.2 

1.2 Tính năng từng phần trong NX:  

1.2.1. Application 

 

- Ứng dụng: NX có chứa một loạt các ứng dụng hỗ trợ công việc khác 

nhau,chẳng hạn như tạo ra một chi tiết, xây dựng lắp ráp, hoặc xuất một bản vẽ. 

- Khi bạn tạo ra một chi tiết, NX bắt đầu ứng dụng thích hợp cho các mẫu 

mà bạn chọn 

- Để bắt đầu một ứng dụng nhấp vào Tab File và chọn 1 ứng dung 

(Moldeling, Assembly, Shape Studio, Sheet Metal …) 

1.2.2 Display Modes 

-  Đóng thanh Ribbon để truy cập các lệnh, nhấp vào Tab hoặc 

nhấn vào phím ALT để hiển thị các Tab đang hoạt động.Sử dụng bánh xe di 

chuyển chuột để di chuyển qua lại giữa các Tab Ribbon. 
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-  Hiển thị thanh Ribbon 

-  Vào và ra khỏi chế độ toàn màn hình, trong chế độ toàn màn hình 

NX đóng các thanh tiêu đề, thanh Ribbon, thanh Border Top và thanh 

Resource để tối đa hóa màn hình hiển thị. 

- Để mở rộng thanh Ribbon trong chế độ toàn màn hình, sử dụng thanh 

tay cầm ở phía trên cùng màn hình  

1.2.3. Ribbon Bar 

 

Hình 1.3 

- Thanh Ribbon: Tổ chức các lệnh trong các nhóm trên Tab. Bạn có thể 

hiển thị và ẩn các lệnh trên thanh Ribbon, các thanh Border và các thanh công 

cụ truy cập nhanh, phù hợp với công việc của bạn. Để tùy chỉnh giao diện người 

dùng rộng rãi hơn, sử dụng hộp thoại Customize. 

- Để hiển thị hoặc ẩn một lệnh trong một nhóm, nhấp vào tùy chọn thanh 

công cụ mũi tên ở góc dưới bên phải của nhóm. 

- Để bật 1 Tab, kích chuột phải vào vùng trống trên thanh Ribbon. 

- Tab File: Hiển thị các lệnh thông thường như mở và Print. Tab này 

cũng cung cấp quyền truy cập vào các ứng dụng mặc định khách hàng, sở thích 

của người dùng và tùy chỉnh, tùy chọn. 

- Tab Home: Hiển thị thường được sử dụng các lệnh cho các ứng dụng 

hiện hành. 

1.2.4 Resource Bar 

- Cung cấp các tùy chọn để đặt các thanh Resource Bar trên một màn 

hình thứ 2. 
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Biểu tượng Chức năng 

 

Resource Bar: Cây thư mục. 

 

History Xem lịch sử những chi tiết được mở trước đó, 

chọn chi tiết và tìm theo thời gian. 

 

Reuse Library Truy cập và sử dụng các thành phần 

trong thư viện sẵn có hoặc bạn đã thêm chi tiết tiêu chuẩn của 

bạn.

 

HD3D Tools Cho phép bạn tìm nhanh chóng và phân 

tích thông tin sản phẩm của bạn hoặc thiết. 

 

Web Brower Dẫn tới Website của Siemens, bạn có thể 

đặt câu hỏi hoặc thảo luận các vấn đề liên quan khi sử dụng 

phần mềm của Siemens.

 

Roles Giúp bạn điều chỉnh giao diện người dùng phù 

hợp với tính năng và tính chất công việc của mình. 

Người dùng có thể lưu lại giao diện với các tùy chỉnh 

do người sử dụng tạo ra. 

1.2.5. Command Finder 

 

Hình 1.4 

- Hiển thị các lệnh bạn tìm kiếm và các lệnh khác có liên quan trong hộp 

thoại Command Finder. Nếu bạn đang chuyển sang NX từ một chương trình 

CAD, nhập tên lệnh từ chương trình trước đó của bạn để tìm một lệnh tương 

đương trên NX. 

- Để bắt đầu tìm một lệnh, nhấp chuột vào nó. 

- Để hiện/ẩn một lệnh, kích chuột phải vào tên lệnh chọn Show/Hide. 
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- Để thêm một lệnh vào vị trí ưa thích, kích chuột phải vào lệnh và chọn 

một trong các tùy chọn Add. 

- Để truy cập trợ giúp cụ thể cho một lệnh, kích chuột phải vào lệnh và 

chọn Help. 

- Để tìm các lênh trong ứng dụng khác, kích chuột phải vào lệnh để khởi 

động ứng dụng. 

1.2.6. Part 

 

Hình 1.5 

- Part: Mô hình chi tiết, lắp ráp, bản vẽ và hầu hết các đối tượng khác mà 

bạn tạo ra trong NX được lưu dưới dạng dữ liệu trong các Teamcenter và được 

xác định bởi số bộ phận. Nếu bạn chạy NX mà không có Setting thì tệp tin được 

lưu với phần mở rộng với đuôi (.prt). 

- Bạn có thể mở nhiều Part một lúc. Để chuyển đổi giữa các tệp tin mở, sử 

dụng Menu Window trên thanh công cụ Quick Access. 

- Khi bạn mở tệp tin có chứa Assembly, NX cũng mở các tệp tin cho mỗi 

thành phần khi cần thiết. 

- Khi bạn tạo một bản, tạo ra nó trong một tệp tin mới mà tham khảo 

thành phần nào đó hoặc là mô hình tổng thể người dùng khác nhau thì có thể 

làm việc trên mô hình tổng thể và bản vẽ cùng một lúc. 

1.2.7 Templaes 

 

Hình 1.6 

- Khi bạn tạo ra một tệp tin NX mới, chọn một mẫu trong hộp thoại File 

New. Vẽ, gia công, mô phỏng hầu hết các mẫu tự động chọn một phần hình học 

3D bạn đang làm việc như là một phần để tham khảo. Tự động hóa các phương 

pháp tiếp cận mô hình tổng thể. 
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1.2.8. Dialog Boxes 

- Để hoàn thành một lệnh, làm việc từ trên xuống dưới trong hộp thoại lệnh. 

Biểu tượng Chức năng 

 

Tùy chọn hộp thoại hiển thị. 

 

Đòi hỏi sự lựa chọn bước hiện tại. 

 

Yêu cầu sự lựa chọn bước Marks. 

 

Chọn thay thế các dấu hoa thị sau khi bạn chọn một đối 

tượng thích hợp. 

 

Lựa chọn tiếp theo đến các tùy chọn cần thiết tiếp theo 

trong hộp thoại. Sau khi cung cấp các đầu vào cần thiết, 

NX kích hoạt các nút Ok, Apply. 

 

Nút Apply hoàn thanh các lựa chọn và giữ hộp thoại mở 

Nút Ok hoàn tất các lệnh và đóng hộp thoại hoàn thành 

các lệnh và tự động đóng hộp thoại khi bạn bắt đầu một 

lệnh mới. 

 

Đặt Reset hộp thoại để thiết lập các mặc định của nó. 

1.2.9 Các dạng thiết kế trong Model 

- Model: Cung cấp các công cụ để thiết kế và chỉnh sửa hình dạng của sản 

phẩm.

- Assembly: Cung cấp các công cụ để lắp ráp cụm chi tiết.

- Shape Studio: Thiết kế tự do, thiết kế công nghiệp theo phương pháp 

nặn hình.

- Sheet Metal: Thiết kế tấm.

- Routing Logiccal: Thiết kế mạch sơ đồ 2D cho các hệ thống đường ống 

và ống dẫn.

- Rought Electrical: Hệ thống mạch điện, tín hiệu va thành phần điện, 

dây dẫn điện. 

- Roughting Mechanical: Xác định hệ thống lực ép do dòng chất lỏng và 

các thành phần của cơ cấu.
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Hình 1.7 

1.2.10. Môi trường làm việc 

 

Hình 1.8 

- 1: Thanh Quick Access Tool Bar chứa các công cụ tùy biến: lưu, sao 

chép, xóa, chuyển đổi đối tượng.  
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- 2: Thanh Ribbon chứa các công cụ thiết kế đăc thù của từng thanh lệnh 

tiêu chuẩn.  

- 3: Menu chứa toàn bộ các tab, thanh lệnh, file…  

- 4: Bộ lọc giúp chọn đối tượng trong quá trình thiết kế và chỉnh sửa. 

- 5: Thanh Top Border chứa các lệnh truy bắt điểm và chế độ di chuyển 

đối tượng.  

- 6: Thanh Resource Bar chứa các thanh hệ thống có sẵn và giúp chọn 

nhanh các đối tượng quản lí trong các môi trường. 

- 7: Chứa những qui trình làm việc. 

- 8: Thanh Status giúp chúng ta biết được trạng thái, nhắc nhở hoạt động. 

- 9: Môi trường làm việc chứa chi tiết. 

Biểu tượng Chức năng 

 

Thiết lập các thông số cài đặt và thông số hiển thị của các 

lệnh, và vị trí các hộp thoại, nhóm và giao diện người dùng.

 

Chuyển sang giao diện dành cho người sử dụng máy tính 

bảng, cảm ứng ở chế độ dùng tay để thiết kế thay chuột.

 

Chuyển đổi các chi tiết khác nhau, các môi trường thiết kế 

khác nhau sau khi mở nhiều chi tiết (file) trong quá trình làm 

việc.

 

Các trợ giúp từ phần mềm NX, chỉ dẫn các đường dẫn lệnh và 

hướng dẫn lệnh từ hãng.

1.3. Thanh công cụ: 

- Kéo thanh công cụ để tháo chúng hoặc gài chúng tới một vị trí khác, Có 

thể mở thêm nhiều thanh công cụ nếu muốn. 

- Dùng biểu tượng tùy chọn của thanh công cụ Toolbar Options để thêm 

hoặc bớt các lệnh. 

- Sử dụng tùy chỉnh Tools→Customize để có các tùy chọn thanh công cụ 

cho riêng mình. 
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1.4. Quản lý thanh công cụ: 

Ở chế độ toàn màn hình, ta vào từng thanh công cụ bằng cách chọn từng 

tab riêng lẻ trên Toolbar Manager. 

 

Hình 1.9 

Biểu tượng Chức năng 

 

Cho phép tạo môi trường thiết kế mới, dữ liệu mới như 

Model, Drawing, Assembly, Simulation … 

 

Mở dữ liệu có sẵn, có thể thiết kế từ NX hoặc các file 

mà phần mềm hỗ trợ. 

 

Chọn nhanh đường dẫn các chi tiết mới làm việc gần đây 

và mở nhanh. 

 

Xác định vị trị và các hiển thị cho một cụm lắp ráp. 
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- Thẻ Open: Mở các file sẵn có 

 

Hình 1.10 

- Thẻ Open a Recent Part: Mở các file làm việc gần đây. 

 

Hình 1.11 

- Và cả thanh Resource cũng có thể hiện thị trên này để mở rộng vùng đồ 

họa cho việc thiết kế. 

+ Nhấp  hoặc chọn View → Full Screen để vào chế độ toàn màn hình. 

+ Nhấp lại  hoặc nhấn ALT + Enter để thoát khỏi chế độ toàn màn hình. 

- Một lưu ý quan trọng cần nhớ là khi bạn không thể tìm ra vị trí của lệnh 

thì bạn dùng Command Finder trên thanh công cụ Standard hoặc chọn 

Help→ Command Finder. 
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1.5. Ray hội thoại 

- Đơn giản là các hộp thoại sẽ được kéo trược trên này, giúp bạn thao tác 

dễ hơn. 

 

Hình 1.12 

- Nhấp đúp vào Rail Clip để ẩn hoặc mở hộp thoại. 

 

Hình 1.13 

 Unclip 

 Clip 

1.6. Hộp thoại 

- Hộp thoại thường gồm các tùy chọn sắp xếp theo mục hoặc nhóm và 

thường theo thứ tự ưu tiên Top-Down. 

- Thu nhỏ các nhóm trong hội thoại nếu không dùng. 

 

Hình 1.14 

- Ẩn tất cả các nhóm trong hội thoại để làm gọn giao diện. 

 Hide Collapsed Groups 

 Show Collapsed Groups 

- Chọn qua nhóm khác để kết thúc lệnh, nhóm mới đang thao tác sẽ có 

màu cam như hình. 

 

Hình 1.15 

-  Biểu tượng dấu sao màu đỏ thể hiện là hình học chưa được chọn 

hoàn toàn. 

- Dấu kiểm màu xanh này thể hiện là các đối tượng đã OK. 
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* Những tùy chọn thường thấy ở hộp thoại. 

- Nhập giá trị vào ô hoặc kéo các mũi tên ở ngoài. 

 

Hình 1.16 

- Thêm các tùy chọn bằng mũi tên màu đen trỏ xuống bên cạnh. Nhấp vào 

lại Reset để về giá trị mặc định ban đầu của nó. 

 Reset 

- Khi tất cả các thông số đã OK, xác nhận lệnh bằng OK hoặc Apply. 

 

Hình 1.17 

- Những ô nào có dạng màu xanh nghĩa là nó là thông số kế tiếp cần điền. 

Không muốn điền mới thì nhấp chuột giữa để chọn giá trị mặc định. 

 

 

Hình 1.18 

- Sau khi chọn, nếu nhấp chuột vào các ô thông số thì tương ứng các đồ 

họa bên ngoài sẽ được tô sáng. 

 

Hình 1.19 

Xem thanh trạng thái các thông số mà bạn cần nhập nếu chưa hiểu. 


